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Advances in modern optical microscopy have provided unparalleled tools to
study intracellular structure and function, yet visualizing lipid molecules within
a cell remains challenging. Stimulated Raman Scattering (SRS) microscopy
is a recently developed imaging modality that addresses this challenge. By
selectively imaging the vibration of chemical moieties enriched in lipids, this
technique allows for rapid imaging of lipid molecules in vivo without the
need for perturbative extrinsic labels. SRS microscopy has been effectively
employed in the study of fat metabolism, helping uncover novel regulators of
lipid storage. This unit provides a brief introduction to the principle of SRS
microscopy, and describes methods for its use in imaging lipids in cells, tissues,
and whole organisms. C© 2015 by John Wiley & Sons, Inc.
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INTRODUCTION

Modern molecular biology demands sophisticated imaging techniques capable of rapid
detection of specific molecules with high sensitivity. In spite of dramatic advances in
fluorescence-based optical microscopy, visualizing certain classes of molecules remains
difficult. Lipids, in particular, are challenging targets to image because they lack intrinsic
fluorescence and cannot easily be fluorescently tagged. The size of the fluorophore often
exceeds the size of the lipid molecule, and the tags are often chemically invasive and
impractical for in vivo applications.

This unit describes a label-free lipid-imaging technique based on the principle of vi-
brational microscopy. Known as Stimulated Raman Scattering (SRS) microscopy, this
method does not require fluorescent tagging, instead relying on the characteristic vi-
brational frequency of the chemical bonds in lipid molecules to identify various lipid
species with high sensitivity and specificity. This unit provides a brief introduction to the
principle and its application in lipid imaging. Details of instrumental setup are provided
in the Basic Protocol. Preparation of Caenorhabditis elegans, live cells, and frozen tissue
sections are discussed in Support Protocols 1, 2, and 3, respectively.
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The Raman Effect and SRS

When light is incident on a sample, the majority of photons interacting with the molecules
scatter elastically (Rayleigh scatter) and maintain their incident energy. However, a tiny
fraction of photons interact with the vibrational states of the molecules in the sample
and scatter inelastically; this is known as spontaneous Raman scattering or the “Raman
effect” (Raman, 1928). The chemical bonds of the molecule may absorb some of the
energy of an incident photon (known as the “pump” photon) and get excited to a higher
vibrational energy level. The scattered photon (known as the “Stokes” photon) will thus
be of lower energy than the incident “pump” photon. Alternatively, a “pump” photon
may interact with chemical bonds existing at a higher vibrational state; in this case, the
scattered photon (known as the “Anti-Stokes” photon) will have higher energy than the
“pump” photon. The difference in frequency between incident and scattered photons is
known as the Raman shift. Each chemical bond in the molecule has a characteristic and
quantifiable Raman shift. The CH2 bond, abundant in lipid molecules, has a Raman shift
of 2845 cm−1 (Thomas, 1999).

In conventional spontaneous Raman microscopy, the signal generated from the spon-
taneous vibrational transition is extremely weak (>8 orders of magnitude weaker than
fluorescence), making imaging a time-consuming process. Instead, the weak Raman
signals can be amplified when two coherent laser beams (set at “pump” and “Stokes”
frequencies) are used to excite the sample. If the difference in their frequencies matches
the vibrational frequency of a molecule in the sample, the molecular vibration transitions
to an excited state due to stimulated excitation. As a result of this coherent excitation,
a “pump” photon is absorbed by the sample and a “Stokes” photon is generated. The
intensity of the transmitted “Stokes” beam experiences a gain (stimulated Raman gain,
SRG), and the intensity of the transmitted “pump” beam experiences a loss (stimulated
Raman loss, SRL). However, if the frequency difference between the two laser beams
does not match the vibrational frequency of the molecule, neither SRG nor SRL signals
will be generated. Therefore, capturing SRG or SRL signals provides the basis for Stim-
ulated Raman Scattering (SRS) microscopy imaging of specific molecules. In principle,
both SRG and SRL signals can be utilized for SRS microscopy imaging (Freudiger et
al., 2008). In practice, the instrumental setup designed for SRL signals (described in
this unit) is much more popular than that for SRG signals. The imaging speed of SRS
microscopy based on SRL signals is around 2 μsec per pixel, which is much faster than
spontaneous Raman microscopy.

Imaging Lipids by SRS Microscopy

All eukaryotes store calories in the form of neutral lipids, comprising primarily tria-
cylglycerols (TAGs) and cholesterol esters (CEs). The fatty acid chains comprising a
TAG/CE molecule are each 14 to 24 carbons in length, and may be saturated (made
entirely of CH2 groups) or unsaturated (containing one or more C=C groups). The neu-
tral lipids are stored in single-membrane organelles known as lipid droplets, which are
highly dynamic and can rapidly expand during caloric excess and shrink with starvation.
The high concentration of CH2 bonds within lipid droplets generates a characteristic
and strong SRS signal at 2845 cm−1 when excited. Neutral lipid molecules can thus be
specifically detected and easily quantified using SRS microscopy in a rapid, label-free,
non-invasive and high-throughput fashion in intact cells, tissue sections, and whole or-
ganisms (Wang et al., 2011; Wei et al., 2013, 2014). The two-photon optical process of
SRS microscopy is comparable to that of two-photon fluorescence microscopy, allow-
ing for subcellular spatial resolution definition even in relatively thick tissue samples.
Unlike canonical lipid-imaging methods that employ dye stains or fluorescent analogs,
SRS microscopy is capable of distinguishing between various classes of lipid molecules
based on their characteristic Raman shifts in a label-free manner.

Label-Free
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Figure 30.3.1 Schematic representation of instrumental setup for SRS microscopy. The “Stokes” beam wave-
length is held constant at 1064 nm and modulated by an acousto-optic modulator (AOM). The optic parametric
oscillator (OPO) is synchronously pumped by a frequency-doubled wavelength from the laser source, which serves
as the “pump” beam. The transmitted beam is collected by a condenser, filtered, and detected by a photodiode.
The stimulated Raman loss (SRL) is demodulated and amplified by a lock-in amplifier. The electric signal from the
lock-in amplifier is subsequently converted into a digital signal and used by a computer for image construction.

BASIC
PROTOCOL

INSTRUMENTAL SETUP FOR STIMULATED RAMAN SCATTERING (SRS)
MICROSCOPY

A variety of approaches to imaging by SRS microscopy have been described in the
literature for various applications. This protocol describes the basic setup and operation
of the SRS system for quantitative lipid imaging. A typical setup for an SRS microscope
is shown in Figure 30.3.1. Two laser beams, “pump” (ωp) and “Stokes” (ωs), are used
to scan the sample under a laser-scanning microscope, and their frequency difference
(�ω) can be tuned to match a particular vibrational frequency (�). The SRL signal can
be specifically picked up, demodulated, and amplified via a lock-in amplifier. The SRL
signal intensity is directly proportional to the concentration of the target molecule in the
sample, and can be easily used for direct quantification. Comprehensive descriptions of
the underlying physical principles are available elsewhere (Min et al., 2011). Detailed
information on the various components of an SRS microscope setup is also available for
further reference (Freudiger et al., 2008; Saar et al., 2010; Yu et al., 2014).

Equipment

Laser system and associated components:

The laser source (Fig. 30.3.1) is the most crucial and complex component of an SRS mi-
croscopy system. Proper setup and calibration are essential for accurate and reproducible
imaging. Excitation of SRS microscopy requires two laser wavelengths, one of which
must be tunable. Typical laser properties include:

Pulse width: 1 to 10 picoseconds (psec)
Repetition rate: 40 to 100 MHz
Power: 30 to 100 mW at the sample plane, for each laser beam.

A commonly used pump laser system for SRS microscopy is the picoTRAIN (High-Q,
532 nm, 7 psec, 76 MHz). Metabolomics
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Other components coupled to the laser system include:

Optical Parametric Oscillator (OPO; Levante Emerald, APE, Germany), required to
tune the “pump” laser beam into different frequencies. The OPO is
synchronously pumped by frequency-doubled wavelength from the laser. The
idler beam of the OPO is blocked by an interferometric filter (Chroma
Technology, 890/220m)

Dichroic beam-combiner (Chroma Technology, 1064 DCRB), to achieve spatial
overlap with the “Stokes” beam

Delay-stage, to adjust the time delay of one laser beam and achieve precise
temporal overlap of “pump” and “Stokes” pulses

Autocorrelator (APE GmbH, PulseCheck), to measure pulse width and ensure
temporal overlap

Acousto-optic modulator (AOM) or electro-optic modulator (EOM), necessary for
high-frequency modulation of the “Stokes” beam. SRL signals are typically
weak and often masked by low-frequency background laser noise. The “Stokes”
beam is therefore modulated at high frequency (>2 MHz) to allow the weak
high-frequency SRL signal to be distinguished from low-frequency laser noise.
Of the two options, AOM is less expensive but cannot be used for very
high-frequency modulation (usually limited to <10 MHz), and is less efficient at
frequencies greater than 5 MHz. EOM can achieve rapid modulation (up to
20 MHz for video rate SRS microscopy) and full modulation depth, but the
modulation frequency is not adjustable.

NOTE: picoEMERALD (A.P.E. GmbH; Fig. 30.3.1) is an all-in-one “turn-key” laser sys-
tem designed specifically as a light source for SRS and other coherent Raman scattering
microscopy systems. It consists of the laser, frequency-doubling unit, AOM, dichroic
mirror, and delay stage. For biological imaging, the system can be set to provide the
“Stokes” pulse at 1064 nm with 7-psec pulse width and 80-MHz repetition rate. The
frequency-doubled beam at 532 nm is used to synchronously seed a picosecond OPO, to
produce a mode-locked pulse train with 5 to 6 psec pulse width. The wavelength of the
OPO is tunable from 720 to 990 nm, which serves as the “pump” beam. The intensity
of the “Stokes” beam is modulated by a built-in AOM/EOM at 2 to 10 MHz, with a
modulation depth of more than 70%. The “pump” beam is spatially overlapped with
the “Stokes” beam with a dichroic mirror inside picoEMERALD. The temporal overlap
between “pump” and “Stokes” beams is ensured with a built-in delay stage. picoEMER-
ALD thus provides fully automated spatiotemporally overlapping “pump” and “Stokes”
beams. Overlap can be further optimized using the SRS signal of pure dodecane (See
‘Steps: Calibration’).

Laser-scanning microscope

The SRS system is based on a two-photon laser scanning microscopy system. The
optical components of the microscope must be optimized for infrared (IR) lasers (750 to
1100 nm). The objectives require achromatic compensation, high numerical aperture
(N.A.), and high near-IR throughput. Either an air lens, an oil-immersion lens, or a
water-immersion lens will work as excitation objective. The overall throughput from the
laser source to the sample plane is typically �15% to 25%, depending on variations in
lens, objectives, and/or wavelengths.

Mirror and filter sets

Several near-IR mirrors with adjustable holders are required to deliver laser beams from
the laser source box to the scanning unit of the microscope. A set of telescopes helps fit
the laser beam size to the back aperture of the objective.

Label-Free
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Detector

A silicon photodiode (FDS1010, Thorlabs) with a large area (typically around 1 cm2)
is widely used for detecting SRL signals, owing to its high linear dynamic range, fast
response, and high quantum efficiency. Furthermore, a reverse DC voltage at 30 to
60 V, pre-filtered by a low-pass filter (Mini-Circuits, BLP-1.9), is applied to the photodi-
ode for reducing its capacitance and increasing response speed (Freudiger et al., 2008).
The transmission light from the sample is collected by a condenser with a higher N.A.
than the objective, reflected by a mirror, and then projected to the photodiode through a
telescope (for adjusting beam size and avoiding beam movement) and a high OD band-
pass filter (to block the “Stokes” beam and selectively transmit the “pump” beam for
SRL detection; Chroma Technology, 890/220m) (Freudiger et al., 2008).

Lock-in amplifier

The detected SRL signals are demodulated and amplified by a lock-in amplifier before
being used for image construction. An amplifier with the following properties is required:

High-modulation frequency (to demodulate SRL signals at high frequency)
Fast output time constant (to allow fast image construction)
High dynamic reserve (>70 dB) (to allow fast image construction)
Long-term baseline stability (to ensure imaging consistency).

Input signals from the photodiode detector are pre-filtered with a band-pass electric
filter (specifically selected for the frequency of “Stokes” beam modulation) to remove
low-frequency noise (due to laser scanning) and high-frequency noise (from laser rate
repetition), and then fed into the lock-in amplifier. The signal from the modulator is
input into the lock-in amplifier as a reference for modulation frequency (Freudiger et al.,
2008).

A/D converter

An A/D converter is used to convert electric analog signals from the lock-in amplifier
to digital signals, which will be subsequently input into a computer. Laser scanning
microscopes are typically pre-installed with an A/D converter.

Imaging Parameters

As explained above, in a typical SRS microscopy system, the “Stokes” beam has a fixed
wavelength and the “pump” beam can be tuned to a different wavelength to match the
vibrational frequency of the chemical bonds/groups of the molecules to be imaged. The
following equation can be used to calculate the wavelength of the “pump” beam for
molecules of interest:

�ω(cm−1) =
(

1

λp(nm)
− 1

λs(nm)

)
× (107nm)

(cm)

Equation 30.3.1

where �ω is the Raman shift expressed in wavenumber, λp is the wavelength of the
“pump” beam, and λs is the wavelength of the “Stokes” beam. Wavenumber is typi-
cally expressed in units of inverse centimeter (cm−1), whereas wavelength is commonly
expressed in units of nanometer (nm). Rearranging the equation to obtain λp:

λp(nm) = 1{[
�ω(cm−1) × (cm)

(107nm)

]
+ 1

λs(nm)

}
Equation 30.3.2
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In a common SRS microscopy system for lipid imaging, the wavelength of the “Stokes”
beam is typically held constant at 1064 nm. The CH2 bond (enriched for neutral lipids
in lipid droplets) has a characteristic Raman shift of 2845 cm−1:

λp(nm) = 1{[
2845 × (1)

(107)

]
+ 1

1064

}
Equation 30.3.3

Solving for λp with these numbers, the calculated “pump” beam wavelength for imaging
CH2 bonds in lipids is 816.76 nm. For optimization of the imaging system, image a
pure reference chemical (such as triolein) and scan a range of wavelengths (calculated
wavelength ± 2 nm, in 0.3-nm steps) in order to identify the wavelength that provides
the strongest signal.

NOTE: The wavelength calculation outlined above in (Equation (30.3.3) is specific to the
CH2 bonds that are commonly used to measure total neutral lipids. To differentiate differ-
ent lipid classes (or image other chemical groups in different molecules), the wavelength
of the “pump” beam must be calculated accordingly to the characteristic Raman shifts
of those molecules (Thomas, 1999). Depending on the nature of the sample, possible
interference must also be considered from other chemicals.

Materials

Sample for scanning (see Support Protocols 1, 2, and 3)
Dodecane: CH3(CH2)10CH3 (Sigma-Aldrich, cat. no. 44010)

Glass microscope slide
Glass coverslips
Immersion oil (if oil-immersion lens is used on microscope)
Bright-field microscope
Equipment for SRS microscopy (see Equipment under the introduction to this

protocol):

Laser system and associated components
Laser-scanning microscope
Mirror and filter sets
Detector
Lock-in amplifier
A/D converter

Software for imaging (e.g., Fluoview from Olympus) and quantification (ImageJ
from NIH; http://imagej.nih.gov/ij/download.html)

Verify SRS signals

When first using an SRS microscope, it is necessary to confirm that the observed sig-
nal is indeed an SRS signal. To verify the identity of the signal, use the following
checklist:

The signal must correspond linearly to both “pump” and “Stokes” laser powers.
The signal must disappear completely when the frequency difference between

the laser beams does not match the vibrational frequency of the molecule of
interest.

The signal must disappear completely when turning off one laser beam.
The excitation spectrum obtained when scanning across a range of frequencies

within the band of interest should be consistent with the Raman spectrum
reported in the literature.

Label-Free
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Calibrate system

1. Turn the power on for the laser source. Allow approximately 20 min for the laser
to power up and equilibrate before image acquisition. In the meantime, turn on the
associated components of the laser-scanning microscope and open the software for
image acquisition.

2. Place a small volume (�10 μl) of pure dodecane [CH3(CH2)10CH3] in the center
of a glass slide, cover with a coverslip, and place at the center of view.

3. Turn the bright-field light source on and direct light to the eyepiece.

4. Ensure that the condenser is positioned such that the image is in sharp focus and the
aperture is located at the center of the view.

5. Start scanning. Adjust the laser power and the focus to obtain a uniformly bright
(but not saturated) image.

When the alignment of the system is optimized, the brightest spot of the dodecane image
should be round and located at the center of the view.

6. Once calibration is complete, begin imaging samples. Recalibrate every time the
system is restarted.

Important parameters such as laser power, throughput, modulation depth, and SRS signal
strength should be measured and recorded for fine-tuning and troubleshooting.

It is critical that the same laser power and imaging parameters be used across all samples
throughout the experiment. A change in any of these properties can significantly alter
signal strength and complicate subsequent interpretation of results.

Image sample

7. Mount the slide containing the sample with a glass coverslip facing the objective
lens. If an oil-immersion lens will be used at the magnification at which the image
is obtained, add a droplet of immersion oil to the coverslip and to the lens at this
step.

8. Turn the bright-field light source on and direct light to the eyepiece of the
microscope.

9. At the lowest magnification, gradually adjust the position of the stage to bring the
sample to the center of view. Bring the sample into focus using the coarse- or
fine-focus adjustment.

10. Switch to the desired magnification. Re-focus the sample.

11. Turn off the bright-field light source.

12. Switch on the laser scanning unit and the diaphragm. Confirm that the “pump” and
“Stokes” beams pass through the laser-scanning unit to the sample, then past the
condenser and filter, to the photodiode detector.

13. Begin scanning the sample. Set a fast scanning rate (e.g., 512 × 512 pixels) at first,
and adjust the fine focus to find the area of interest.

14. Switch to a slower scanning rate and higher resolution (e.g., 1024 × 1024 pixels)
without altering the focus.

A scanning rate typically used for SRS imaging is 2 μsec/pixel.

15. Obtain an SRS signal image, and save it as a high-resolution image (such as a.tiff
file).

Metabolomics
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16. If there are multiple samples on the same slide, switch back to the faster scanning
rate and slowly adjust the position of the stage to bring the next sample in the
center of view. Repeat steps 13 to 15 to finish imaging all the samples on the same
slide.

17. Once the desired samples on the slide have been imaged, close the diaphragm below
the stage to block the laser beams (do not turn off the laser source). Carefully remove
the slide.

18. Place the next sample slide, and repeat steps 7 to 15.

19. Once all samples have been imaged, turn off the laser source and associated equip-
ment, the microscope, and the computer.

Analyze lipid images with ImageJ

20. Open the image files to be quantified in ImageJ [go to “File → Open” to select
files individually, or select all files (in Windows, use “Control” plus mouse click;
in Mac OS X, use “Command” plus mouse click), drag the files, and drop into the
ImageJ window. If several files are opened simultaneously, cascade or stack the
image windows (select “Window → Cascade” or “Window → Tile”).

21. Choose the properties to be analyzed under “Analyze → Set Measurements”. Check
the desired parameters and click OK to close the window.

Typical parameters to be measured include “Area,” “Standard deviation,” “Min and max
gray value,” and “Mean gray value” (Fig. 30.3.2A), although several other measurements
can be made with ImageJ.

22. In the ImageJ window, click on the polygon selection tool (Fig. 30.3.2B). On one
opened image window, carefully outline the region to be quantified as follows:

a. Click once on an outer edge of the desired region.
A selection anchor is placed at that point.

b. Move the pointer along to an adjacent point on the border, and click again to
place an anchor.
A straight line is drawn between the first and second anchors (Fig. 30.3.2C).

c. Repeat the process, drawing a series of small lines that outline the region to be
quantified.

d. The polygon is completed once the first anchor is clicked again (Fig. 30.3.2D).

23. To measure the parameters selected in step 21, go to “Analyze → Measure” or
use the keyboard shortcut (in Windows, use “Control plus M”; in Mac OS X, use
“Command plus M”). A new “Results” window opens to display the measured
values (Fig. 30.3.2E).

24. Close the image window.

25. Repeat steps 22 to 24 for each open image.

26. In the results window, select all the measurements (click on the Results window,
then “Edit → Select all”). Copy all measurements to the clipboard (“Edit → Copy”)

27. Paste the results into a new Microsoft Excel file. Proceed with quantification and
statistical analysis as desired.

To ensure that all images have the same distribution of pixel intensities, set the window of
displayed brightness and contrast to maximum. Go to “Image → Adjust → Brightness
and Contrast.” In the window that opens, click on “Set” and choose the following
(Fig. 30.3.2F):
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Figure 30.3.2 Quantification of neutral lipid stores using ImageJ. Refer to text for details.

Minimum displayed value: 0

Maximum displayed value: 4095

Check the box to select “Propagate to all other open images”

Click “OK” to close the window.

This is important for displaying comparative images consistently across samples, for
instance when presenting images of wild-type/control and mutant/treated samples in
a publication. Note that altering the displayed values will not affect the results of
measurement.
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Figure 30.3.3 Preparation of agarose pads and C. elegans samples for SRS imaging. Refer to text for details.

SUPPORT
PROTOCOL 1

PREPARATION OF C. ELEGANS SAMPLES FOR SRS IMAGING

Caenorhabditis elegans is an excellent model organism for multiple imaging techniques.
Since it is whole-body transparent, various tissues can be imaged in the intact animal
without the need for dissection. These worms are also useful for high-throughput screens
owing to the availability of genetic tools, small size, and easy handling.

In C. elegans, neutral lipids are largely stored in the intestine, which consists of 20
epithelial cells located bisymmetrically around the intestinal lumen. Hypodermal cells
and oocytes also store lipids. Many regulatory factors involved in lipid storage and
distribution are conserved between C. elegans and higher organisms. We found that
C. elegans lipid droplets consist mainly of triacylglycerols (TAGs), which generate
strong SRS signals due to the abundance of CH2 bonds present in fatty acid chains.
Applying the SRS system to this genetically tractable model organism has facilitated
discovery of new genetic regulatory factors of lipid metabolism (Wang et al., 2011).

This protocol describes the preparation of C. elegans samples for SRS imaging. Briefly,
prepare the slides with agarose pads and mount the worms onto the pads. The agarose
pads help to prevent worms from being crushed between the coverslip and the glass slide,
and also help the worms stay moist and avoid desiccation. Follow the steps depicted in
Figure 30.3.3.

Materials

Agarose (GeneMate, cat. no. 3119)
C. elegans (Caenorhabditis Genetics Center, University of Minnesota)
M9 buffer (see recipe)
Anesthetizing agent (sodium azide or levamisole)

Heat block
General-purpose laboratory labeling tape

Label-Free
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Glass slides and coverslips
Glass Pasteur pipets and pipet bulbs
Dissection microscope
Worm picker (platinum wire fixed at the tip of a Pasteur pipet; optional)

Preparing the agarose pads

1. Prepare 2% agarose solution in distilled water. Place the melted agarose on a heat
block (at approximately 200°C) while preparing the slides.

2. Prepare two support slides by placing two layers of laboratory tape on each. Place
these support slides on each side of a blank slide (Fig. 30.3.3A).

The support slides will ensure that the pad thickness (�0.2 mm) will stay the same across
all of the samples.

3. Place one drop of warm 2% agarose onto the blank slide using a glass Pasteur pipet
(Fig. 30.3.3A).

4. Quickly place a second slide on top of the agarose drop, at a 90° angle to the three
slides (blank slide and two supporting slides; Fig. 30.3.3B), and gently press the
edges of this slide such that the agarose drop spreads in a circle (Fig. 30.3.3C). Set
these slides aside; do not separate the two glass slides holding the agarose pad until
the samples are ready.

Prepare fresh agarose pads for each imaging session.

Mount the worms

5. Pick the worms to be imaged under the dissection microscope and add them to a
droplet of M9 buffer with anesthetizing agent such as sodium azide or levamisole,
placed on a coverslip (Fig. 30.3.3D; generally, 4 to 5 μl of 75 μM sodium azide or 1
mM levamisole is sufficient for 10 to 20 worms). Adjust the droplet size as needed.
Once all the worms are added to the drop of anesthetizing agent, move them around
within the droplet using a picker so that they do not overlap with each other.

Levamisole is recommended if the worms need to be recovered after imaging.

6. Once the worms are anesthetized, separate the glass slides (from step 4) without
perturbing the agarose pad. Take the glass slide containing the agarose pad and cover
the worms with this slide with the pad facing down towards the worms (Fig. 30.3.3E).
Alternatively, place a droplet of sodium azide/levamisole on the agarose pad, pick
worms onto the droplet, and cover the droplet with the coverslip.

7. To easily locate the worms when imaging, mark the position of the worms on the
coverslip with a permanent marker. Proceed with imaging as described in the Basic
Protocol.

For total lipid content quantification, there is no need to fix or stain the worms. If fixing
is the preferred method, the use of plastic, paraffin, or oil (all rich in CH2 bonds and
bearing strong Raman signals) must be avoided. Formaldehyde solutions may be used for
fixing, but ethanol or other organic solvents that may dissolve lipids from samples should
be avoided for sample preparation.

SUPPORT
PROTOCOL 2

PREPARATION OF CULTURED CELLS FOR LIVE-CELL IMAGING BY SRS
MICROSCOPY

SRS microscopy is a noninvasive, label-free imaging modality that is amenable to live-
cell imaging with minimal preparatory steps. Cells are grown on glass-bottom dishes and
imaged directly, with no fixation or staining required. Care must be taken to maintain
cellular integrity before and during imaging. Metabolomics
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Materials

Cells of interest
Appropriate growth medium

Uncoated glass-bottom dishes (MatTek, cat. no. P35G-1.0-14-C)
Upright or inverted microscope with 60× water objective
Water condenser

1. Grow cells on uncoated glass-bottom dishes with the appropriate growth medium and
culture conditions.

Components of the growth medium may interfere with the SRS signal. To check for this
possibility, image a small volume of fresh growth medium at the difference frequency to
be used during cell imaging. If an SRS signal is obtained from fresh growth medium, test
other alternative/minimal media. If no alternative is available, replace growth medium
with 1× PBS (APPENDIX 2) and image the cells as quickly as possible.

2. Culture cells to the required degree of confluency.

A very high degree of confluency may affect the ability to visualize single cells.

3. Place the dish on the stage.

If using an upright microscope

4a. Position the stage such that the water objective is in contact with the medium, as
close to the cells as possible.

5a. Add 1 to 2 drops of water to the water condenser lens and ensure contact with the
bottom of the glass dish.

If using an inverted microscope

4b. Add 1 to 2 drops of water to the objective lens and ensure contact with the bottom
of the glass dish.

5b. Position the stage such that the water condenser is in contact with the medium, as
close to the cells as possible

6. Proceed with imaging as described in the Basic Protocol.

Imaging should be performed within 30 min to prevent sample deterioration/degradation.

SUPPORT
PROTOCOL 3

PREPARATION OF FROZEN TISSUE SECTIONS FOR IMAGING BY SRS
MICROSCOPY

Both fresh and frozen tissue slices can be imaged by SRS microscopy. For example,
fresh mouse brain slices are commonly imaged using SRS microscopy (Ji et al., 2013).
Preparation of fresh brain slices is straightforward. Once the brain is harvested, place it
in a brain mold that matches the age of the mice. Slice sections manually at regular size
intervals using a razor blade. Depending on the mold, these intervals range from 0.5 mm
to 3 mm. After slicing, mount sections onto glass slides and cover them with coverslips.
Image as soon as possible.

Frozen sections can be unfixed or formaldehyde-fixed. However, use of organic solvents
other than formaldehyde should be avoided because they can dissolve lipids, disrupt the
lipid storage compartments, and generate imaging artifacts. The use of plastic, paraf-
fin, or wax (all rich in CH2 bonds and bearing strong Raman signals) must also be
avoided. If the tissue is not going to be imaged freshly, the dissected tissue should be
frozen or fixed promptly before the cell destruction starts. Slow freezing can distort the
tissue due to ice-crystal formation and expansion. The goal should be to freeze rapidly
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such that water does not have time to form crystals, and will thus not expand when
solidified. This technique is often referred to as “snap-freezing” or “flash-freezing”
(Scouten and Cunningham, 2012). After freezing, the tissue can be stored at −80°C
until sectioning using cryostat. The thickness of frozen sections can range from 5 μm to
300 μm.

Materials

Isopentane (2-methyl-butane)
Liquid nitrogen
Dry ice
Tissue sample
Tissue freezing medium (Triangle Biomedical Sciences)
Gum tragacanth (Sigma-Aldrich)
Phosphate-buffered saline (PBS; APPENDIX 2)

Metal beaker
Liquid nitrogen canister
Petri dish
Cryomolds
Long metal forceps
Cryostat (Leica CM3000)
Treated glass slides (e.g., Superfrost Plus Sides from VMR)
Coverslips

1. At least 10 min before freezing the sample, prepare cold isopentane. Fill two-thirds
of a metal beaker with isopentane and place the metal beaker in a liquid nitrogen
canister. At the same time, prepare a bucket with dry ice.

2. Place the dissected tissue in a Petri dish and cover it with 3:1 (v/v) tissue freezing
medium:gum tragacanth mixture. This step will acclimate the tissue to freezing
medium.

3. Transfer the tissue to a cryomold and cover it with 3:1 tissue freezing:gum tragacanth
mixture. Orient the tissue in the preferred position for sectioning—the bottom of the
cryomold will be the sectioning surface. Avoid formation of bubbles, especially near
the tissue.

4. Using long metal forceps, freeze the tissue by partially submerging the cryomold
into the cooled isopentane. Do not fully submerge. After the freezing medium mix-
ture is frozen, place the cryomold on dry ice until all of the tissue samples are
frozen.

5. When freezing of all of the samples is complete, wrap the cryomolds with aluminum
foil individually and store in a plastic bag at −80°C until sectioning.

6. When ready to section, use a cryostat to create 10 μm-thick sections, and mount on
treated glass slides.

7. Add a drop of PBS onto the tissue section and cover with a coverslip.

The slide can then be directly imaged (see Basic Protocol).

For SRS imaging, one should avoid using mounting medium containing glycerol, which
would emit a strong SRS signal.

Fixing the tissue sections directly is also possible, and is recommended for long-time
imaging and preserving samples. To fix sections that are mounted onto slides, place frozen
slides to 3.7% formaldehyde (in PBS) for 30 min, and then cover with a coverslip.
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REAGENTS AND SOLUTIONS

Use deionized, distilled water in all recipes and protocol steps. For common stock
solutions, see APPENDIX 2; for suppliers, see SUPPLIERS APPENDIX.

M9 buffer

3 g KH2PO4

5 g NaCl
6 g Na2HPO4

1 ml 1 M MgSO4

Distilled H2O to 1 liter

COMMENTARY

Background Information
Obesity has reached epidemic proportions

worldwide and is a significant risk factor for
serious health problems such as type II dia-
betes, cardiovascular disease, and certain types
of cancer (Lawrence and Kopelman, 2004;
Ogden et al., 2014). To defend against the
obesity epidemic, significant research efforts
are underway to better understand the regu-
latory mechanisms of lipid metabolism and
storage. Lipids lack inherent fluorescence and
cannot be tagged with fluorophores due to their
small size. For quantitative detection of lipid
molecules in samples, the label-free imaging
technique of SRS microscopy is a reliable al-
ternative to the traditional methods.

Traditional approaches to lipid storage
analysis have involved biochemical assays or
fixation and staining protocols. Comparative
analysis of label and label-free methods is
available in Yen et al. (2010), Folick et al.
(2011), and Yu et al. (2014). Biochemical
quantification assays such as TLC or GC/LC-
MS can provide detailed analysis of the com-
position of various lipid molecules. However,
they require very large amounts of sample,
and sample preparation usually takes several
hours. Another major limitation of these as-
says is that no spatial information on the dis-
tribution of lipid droplets is obtained. Lipid
dyes such as Oil Red O and Sudan Black
provide useful cellular information on lipid
droplets. The assays are of low cost and the
protocols relatively straightforward. However,
these staining protocols require fixation, which
can sometimes generate artificial morpholog-
ical changes in lipid droplets and result in in-
consistency between samples.

The use of coherent Raman scattering
(CRS) microscopy in biomedical research has
increased rapidly in recent years. The two
most commonly used CRS microscopy modal-
ities are Coherent Anti-Stokes Raman Scatter-
ing (CARS) microscopy and SRS microscopy.

They have slightly different working princi-
ples, but both are label-free imaging tech-
niques that require only a small sample that
can be prepared for imaging in minutes. CARS
signals generate non-resonant background sig-
nals even in the absence of vibrational res-
onance, which limits the detection sensitiv-
ity and specificity (Evans and Xie, 2008).
In addition, they have a nonlinear relation-
ship to the molecule concentration, which
complicates quantification. Unlike CARS mi-
croscopy, SRS microscopy does not generate
non-resonant background signal and offers di-
rect linear quantification of analyte concen-
tration. Currently, the major limitation of this
technique is the cost of the equipment. We an-
ticipate that new technological advances and
commercial availability will lower the cost and
expand use of SRS microscopy in biomedical
research.

Critical Parameters and
Troubleshooting

Building the SRS microscopy system and
finding the SRS signal

The SRS system is based on a two-photon
laser-scanning confocal system. For com-
patibility with SRS microscopy, ensure that
the optical components of the microscope
are optimized for IR lasers. The most critical
added component of the system is the laser
source. It is essential that the pulse width,
power, and repetition rate of the laser meet
the criteria described in the Basic Protocol.
Similarly, the lock-in amplifier must meet all
the properties described in order to extract
the signal efficiently and construct the image.
Also, ensure that the “Stokes” beam is
modulated at high frequency (> 2 MHz) to
minimize background.

Sample preparation for SRS imaging
Preparing samples for SRS imaging is not

very different than sample preparation for
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Table 30.3.1 Troubleshooting SRS Imaging of Lipids

Problem Cause Solution

Problems caused during imaging

No SRS signal “Pump” or “Stokes” beam
wavelength used is incorrect
Light is not focused on the
sample
AOM is not working
Photodiode is improperly
functioning

Re-calculate frequency difference. Check that the lasers are
tuned to vibrational resonance.
Calibrate with pure reference chemical (dodecane/triolein)
prior to imaging samples.
Scan a range of wavelengths (± 2 nm).
Ensure proper mirror alignment and condenser placement
(critical).
Ensure that AOM is functioning (check with a fast
photodiode). Re-check settings of lock-in amplifier;
reference to right modulation frequency.
Removing excitation filter; photodiode should obtain a
strong signal from the modulated excitation beam.

SRS signal too
weak/too high

Laser is not aligned to the
center of the scanning area
Laser power is too low/too
high
Amplifier settings are
incorrect
Low/high lipid levels in the
sample

The laser should be aligned to the center of the scanning
area using dodecane oil and by adjusting the mirror angles,
before imaging samples. If changing the laser power or
amplifier settings cannot increase the signal, then calibrate
the setup again.
On the image acquisition software, set the pixel intensity
such that the background will be almost zero. Also avoid
excess saturated pixels.
A general rule of thumb is to image wild-type/control
samples first, arrange the settings accordingly, and keep
those parameters constant during the analysis of
mutant/treated samples.

High background Amplifier/detector settings
are incorrect
Transferred excess bacteria
when picking worms
Cell culture medium
generates background signal

Minimize transfer of bacteria while picking the worms, as
this may contribute to high background.
Replace with alternative medium/PBS. Image as soon as
possible.

Cannot focus on the
sample

Objective lens may be dirty Make sure the lenses are clean. Clean only with lens cleaner.
Use immersion oil for higher magnification objectives.

Problems caused during sample preparation

Worms are still mobile
in the anesthetizing
solution

The concentration of the
anesthetizing solution is
insufficient

Wait for several minutes after adding worms to the
anesthetizing solution.
Increase the concentration of sodium azide or levamisole
modestly. If worms must be recovered after imaging, avoid
highly concentrated solutions of these compounds, as they
may kill worms.

Worms burst frequently The samples waited too long
for imaging after preparation
Volume of the anesthetizing
solution is too low or its
concentration too high
Concentration of the agarose
solution used for the pad is
too high

Whole worm samples need to be imaged within
approximately 30 min. Preservation at 4°C for a few more
hours longer is possible, but samples cannot be recovered.
If worms burst even within 30 min, the agarose pad or the
anesthetizing solution might be causing the problem. Lower
the concentration of the agarose or the anesthetizing
solution. Also try increasing the volume of anesthetizing
solution.

Worms scatter too
much on the agarose
pad

Volume of anesthetizing
solution is too high
The agarose pad is too large

Place anesthetizing solution onto the coverslip.
Drop a smaller volume of agarose solution to make the pad.
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other imaging purposes. However, certain fac-
tors need special attention. In general, fresh
samples should be imaged as soon as possible
after mounting them onto the slide, to prevent
sample deterioration and lipid droplet coales-
cence. If the sample will be fixed, then the use
of ethanol or other organic solvents should be
avoided, since they may dissolve lipids from
samples. Formaldehyde is safe to use with SRS
microscopy. For cell imaging, the choice of
medium is important; the medium itself may
interfere with the SRS signal. The medium
should be imaged independently for any SRS
signal at the same difference frequency used
for sample imaging.

Troubleshooting
Table 30.3.1 describes some problems com-

monly encountered with SRS imaging of lipids
along with descriptions of possible causes and
recommended measures for overcoming or
avoiding these problems.

Anticipated Results
SRS microscopy can be utilized to selec-

tively visualize lipid stores in tissue sections,
in live cells, and in whole organisms such as
C. elegans. Cells/animals with genetic muta-
tions, or those exposed to different environ-
mental conditions (such as starvation, temper-
ature changes or diet), can be imaged, quan-
tified, and compared to their corresponding
controls. The spatial resolution of SRS mi-
croscopy is comparable to that of two-photon
fluorescence microscopy (�300 nm in the x–y
plane and �1000 nm on the z axis, depending
on objectives and wavelengths used), allow-
ing for lipid molecules to be visualized at the
subcellular level. In live cells and C. elegans,
SRS microscopy can reveal individual lipid
droplets, including nascent droplets that may
be particularly small. Furthermore, the use of
near-infrared lasers allows for high penetration
depths of up to 1 mm (Helmchen and Denk,
2005). This is particularly useful for imaging
the spatial distribution of lipid molecules in
thick tissue samples such as mouse skin, liver,
and brain.

Different classes of lipid molecules are
structurally diverse, and canonical lipid imag-
ing methods that use dye staining or fluo-
rescent analogs cannot distinguish these dif-
ferent classes. In contrast, SRS microscopy
can differentiate specific lipids based on dif-
ferences in their fatty acid chains (Fu et al.,
2014).

Time Considerations
Generally, at least 20 worms should be ana-

lyzed for each mutant or condition. With prac-
tice, it is possible to image worms from three
to four different mutants/conditions or a to-
tal 60 to 80 worms per hr. For the purpose of
a high-throughput genetic screen, the imaging
parameters can be suitably adjusted to increase
this number; for instance, scanning speed can
be increased at the cost of lower image reso-
lution for first-pass screening.
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